
Cool Google Tips & Tricks

✅Find Out What Google Knows … and Delete it!
✅Google Fonts website
✅12 tips for using Google Apps with young students
✅List of Random Names
✅To find info about your Chrome OS
✅16 Ideas for Student Projects using Google Docs, Slides, & Forms
✅Chromebook Apps for Digital Storytelling

Google Admin✅

Google Calendar✅
✅How to Print Your Google Calendar
✅Reminders for Google Calendar on the web
✅Manage Your Personal Calendar In Sync With Your Team Calendar
✅Event Mergeffdx
✅5 Things to Explore in Google Calendar

Google Chrome✅
✅Better Searches. Better Results.
✅Chrome Browser … Why Use It?
✅How to Back-Up Bookmarks in Chrome

Google Extensions, Add-Ons, & Apps✅
Extensions:
Apps:
Add-Ons:
Click here
Chrome Timer Extensions
QuickShare Screenshot
Toby Extension

Chromebooks✅
✅Chromebook Shortcuts Reference Sheet
✅Enroll Chrome devices
✅Wipe a Chrome Device
✅To find info about your Chrome OS
✅5 Ways to Stop your Chromebook Slowing Down
✅To find info about your Chrome OS

Google Classroom✅
Google Classroom Cards To Get Started
✅Set a Custom Grading Scale in Google Classroom

Back to Top



✅Share to Classroom Extension
✅Schedule That Assignment
✅List ALL Your Student Files
✅NEW! Guardian Contacts & Email options
✅10 Google Classroom Time Savers
✅35 Awesome Apps that Integrate with Google Classroom
Private Comment as Assignment
✅Michael Fricano II

John Sowash

Google Docs
Force Others to Make a Copy of a Document
Find the Word Count in Your Google Doc with this Keyboard Shortcut
Using bookmarks in a document
Restrict Viewing/Commenting in Docs to a Time Period
Creating a Writing Journal with Google Docs
Adding Emoji’s in Google Docs
Showing the Outline in Google Docs
HyperDocs
Interactive Checklists in Google Docs
Lesson Plan Tool for Google Docs
How to Email & Download a Google Doc as a PDF or Word Doc

Email a Google Doc as a PDF/Word doc:
Download a Google Doc as a PDF/Word doc:

Use Google Docs to fill out PDF’s
Use the Explore Button in Docs
Transcribe Images Into Editable Docs
Customize Docs Background
New & Improved Voice Commands
Easy Way to Color Code & Organize Ideas in a Google Doc

Google Drawing
Graphic Organizers in Google Drawings
Google Drawing Resources
5 Apps Templates to use with Kindergarteners

Google Drive✅
✅Add a Google File to Multiple Folders in Drive
✅Set the Expiration Date on Your Google Drive, Docs, Sheets & Slides
✅How to Insert Special Characters in Google Docs, Slides and Drawings
How to Password Protect Your Google Drive Documents on Your iPhone

Google Earth
Google Earth Walks

Google Forms

Back to Top



An Intro to Google Forms
Multiple Google Forms to One Spreadsheet
Templates!
Track Survey Progress and Analyze the Results
Receive Notifications and Status Updates
Restrict Access to Google Forms with These Two Options
Where to Locate and Download Google Form Add-ons
Forms Quiz Grading Feature
Add Images to Q & A in Forms
Choose Your Own Adventure Forms
“Smarter” Question Options
Make Sequencing Questions with Google Forms
Password Protect Google Forms

GMail
Export & Edit Your Gmail Contacts in Bulk

Google MyMaps
MyMaps Helps site
20 ways Google MyMaps can enhance lessons in any class
Google’s Geography Trivia Game → Smartypins

Google Sheets
“An Intro to Google Sheets”
Calculate how many days you have to work on a project
Make sure you are collecting real email addresses
Translate foreign languages
How to Rotate Text in Google Spreadsheets
To rotate your text vertically:
To customize the degree in which you want to rotate your text:
Say goodbye to duplicates (in Sheets)
Find Duplicates in Sheets
How to do text-to-columns in Google Spreadsheets
Creating Pixel Art Using a Google Sheets Template
Student Reading Log Template w/Sheets
Building a Table of Contents in Sheets
Create an Org Structure in Sheets
5 Apps Templates to use with Kindergarteners
How to Automatically Alternate Row/Column color in Sheets
How to Split Text into Columns
Insert Images into Sheets
Send Text Messages in Sheets
Dynamic Dropdown Menu’s in Sheets
Use the Explore Button in Sheets
Merge Data into One Column

Back to Top



Clarify Your Charts Using Data Labels
copyDown Add-On for Sheets
Rotate text & border options in Sheets

Google Sites
The All New Google Sites (help)

Google Slides
An Intro to Google Slides
Activities to do with Slides
Google Slides Cheat Sheet
5 Apps Templates to use with Kindergarteners
Use the Explore Button in Slides
Free Templates for Slides
Use your mouse as a laser pointer

Google Tour Creator

Back to Top



✅Find Out What Google Knows … and Delete it! (TYCD R: Nov. 9, 21)

Link

✅Google Fonts website

✅12 tips for using Google Apps with young students
LINK

✅List of Random Names
Generate a list of random names @ http://listofrandomnames.com/

✅To find info about your Chrome OS
LINK Type chrome://system

✅16 Ideas for Student Projects using Google Docs, Slides, & Forms
LINK

✅Chromebook Apps for Digital Storytelling
Check out this website → click here
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Google Admin✅

Google Calendar✅

✅How to Print Your Google Calendar
It only takes a few steps to print your Google Calendar. Whether you’re on the go, or you cell phone battery is
low, it’s nice to have a hard copy of your calendar on hand. All you have to do is:

1. Go to the More dropdown in the top right.
2. Click print.
3. You’ll have two options – print or save as .pdf.
4. You’ll have multiple formatting options, including the orientation of the calendar (portrait or landscape).
5. You can show or not show events that you have declined.
6. You can choose black and white if you are printing in black and white, for better contrast.
7. Hit print or save as .pdf and you’re done!

✅Reminders for Google Calendar on the web
(click for the link)

✅Manage Your Personal Calendar In Sync With Your Team Calendar
There is another way to achieve shared team visibility with less chance of confusion. It will keep everyone in sync with
your personal events that they need to be aware of without all the congestion. When you make changes to the event it will
be visible to everyone who needs to know without constantly sending them notifications. (click the title for the link)

✅Event Merge

Event Merge combines the same event on multiple Google Calendars into one striped event. For instance,
some of your appointments may be listed on both your personal and work calendar, which can make your
calendar cluttered and distracting. With Event Merge, you can tell at a glance which separate events have
been merged, making your calendar much more organized and clean.
Click here to watch this video on YouTube. (Credit)
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✅5 Things to Explore in Google Calendar
LINK - Alice Keeler with tips on Google Calendar

Google Chrome✅

✅Better Searches. Better Results.

This is a link to a poster you can print & display in your classroom (or post digitally) for you & your students to
use when researching on the web. Click here for the link. Some nifty modifiers to type in your Google search
box to refine your searches and get the best results.

✅Chrome Browser … Why Use It?
PDF giving 6 reasons why … click here

✅How to Back-Up Bookmarks in Chrome
Open Google Chrome and click on the Customize and Control Google Chrome menu > Bookmarks > Bookmarks
manager (or press [CTRL] + [Shift] + [O]). Click on the Organize menu > Export bookmarks to HTML file: Choose a
location to save the file and click on Save.

Google Extensions, Add-Ons, & Apps✅

Extensions:
are extra features & functionality that show up to the right of your URL box.

Apps:
are like software you install

● easiest to find on your Chromebook by click on the magnifying glass on your keyboard
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Add-Ons:
are from 3rd party developers that you can add on Google Docs, Sheets, & Forms to add additional

functionality

● found when you are IN a Doc, Sheet, or Form - look for “Add-Ons” under your document title

Click here
for a doc that gives suggestions for & reasons why/how to use some pretty cool ones in Chrome.

Chrome Timer Extensions
LINK

QuickShare Screenshot
By Alice Keeler LINK
Save your screenshots instantly to Google Drive. A link to the screenshot is saved to your clipboard allowing you to
quickly share. It will save into a folder in your Google Drive.

Toby Extension
LINK Try Toby, a Chrome extension that lets you drag and drop your tabs and organize them into neat visual
lists. Toby’s interface is remarkably clean, simple, and easy to use. Here are four great features, plus an
exciting new feature being released today.
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Chromebooks✅

✅Chromebook Shortcuts Reference Sheet

(credit)

Any items in this purple color are shortcuts I’ve added.

Google’s Chromebook Help website

Ctrl+N Open a new window

Ctrl+C Select text to make a copy of

Ctrl+V Paste selected text

Ctrl+X Select text to cut (then use Ctrl+V to paste where you want it)

Ctrl+Z To undo previous action

Click & hold on the square in the upper R corner; then
slide -while holding- to the R or L, depending on your
preference

To automatically create a ½ sized screen

Click, hold & drag a tab down & out of the browser
To separate the tab from your others; you can repeat the ½ sizing
to have a split screen

Ctrl+Shift+N Open a new window in incognito mode

Ctrl+Shift+
take a screenshot of selected area

Ctrl+
take a screenshot of entire screen

Ctrl+T Open a new tab

Ctrl+O Open a file in the browser

Ctrl+Shift+Q Sign out of your Google Account on Chrome OS

Ctrl+W Close the current tab

Ctrl+Shift+W Close the current window

Highlight a word or phrase & then Ctrl+K Inserts a hyperlink to the selected word/phrase

Ctrl+Shift+T
Reopen the last tab you've closed. Google Chrome remembers
the last 10 tabs you've closed.

Ctrl+1 through Ctrl+8 Go to the tab at the specified position in the window

Ctrl+9 Go to the last tab in the window

Alt+1 through Alt+8 Go to the window at the specified position

Alt+9 Go to the last window open

Ctrl+Tab Go to the next tab in the window

Ctrl+Shift+Tab Go to the previous tab in the window

Alt+Tab Go to the next window you have open

Alt+Shift+Tab Go to the previous window you have open
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Click and hold the Back or Forward arrow in the browser
toolbar

See your browsing history for the tab

Backspace, or press Alt and the left arrow Go to previous page in your browsing history.

Shift+Backspace, or press Alt and the right arrow Go to the next page in your browsing history.

Press Ctrl and click a link Open the link in a new tab in the background

Press Ctrl+Shift and click a link Open the link in a new tab and switch to the newly opened tab

Press Shift and click a link Open the link in a new window

Drag a link to a tab Open the link in the tab

Drag a link to a blank area on the tab strip Open the link in a new tab

Type a URL in the address bar, then press Alt+Enter Open the URL in a new tab

Press Esc while dragging a tab Return the tab to its original position

Ctrl+Shift+L Locks your screen

✅Enroll Chrome devices

This article is for Chrome for Work and Education administrators.

To enforce the policies you set in the Admin console on your Chrome devices, you need to enroll the devices in
your domain. Each device you enroll adheres to the Chrome management policies you set in the Admin
console until you wipe or recover the device.

Note: You must enroll a device before any user signs into it (including you as the administrator). If a user signs
in first, your policies will not apply, and you must wipe the device to restart enrollment.

Manually enroll Chrome devices

1. Turn on the Chrome device and follow the onscreen instructions until you see the sign on screen. Don't
sign in yet.

2. Before signing in to the Chrome device, press Ctrl+Alt+E to go to the enrollment screen.
3. Enter the username and password from your Google admin welcome letter, or the username and

password for an existing Google Apps user on your account that has eligibility to enroll.
4. Note: You can control which users can enroll in your domain with the Enrollment Permissions user

policy.
5. Click Enroll device. You'll receive a confirmation message that the device has been successfully

enrolled.

Once enrolled, you can find the device in your Admin console by clicking Device management > Chrome
devices.

Note: By default, devices are enrolled into the top-level organization for your domain. You can change where a
device is enrolled with the Device Enrollment user policy.

✅Wipe a Chrome Device
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1. Press Esc + + Power. A yellow exclamation point (!) is displayed.
2. Press Ctrl + D to begin dev mode, then Enter. A red exclamation point is displayed.
3. Press Ctrl + D. The Chromebook deletes its local data, returning to its initial state. This takes

approximately 15 minutes.
4. If Forced re-enrollment is enabled for the device, you'll see a note that developer mode is blocked. This

shortens the wipe process, and still allows for re-enrollment when the device automatically reboots into
verified mode.

5. When the transition completes, press the spacebar, then press Enter to return to verified mode.
6. Enroll the Chromebook before signing in to it.

✅To find info about your Chrome OS
LINK Type chrome://system

✅5 Ways to Stop your Chromebook Slowing Down
LINK → “Here are the tricks that ultimately fixed my Chromebook’s speed and made it like new again.
Try them for yourself.”

✅To find info about your Chrome OS
LINK Type chrome://system
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Google Classroom✅

Google Classroom Cards To Get Started
Need an easy visual providing step-by-step instructions on the creation of Google Classroom? Click here.

✅Set a Custom Grading Scale in Google Classroom
Google Classroom puts the default point value for assignments created at 100 points. But as we all know, not
every assignment is out of 100 points. With a weighted grading system it is even more important to set correct
grading scales for each and every assignment.

Today we will look at how easy it is to customize the point value for your assignments to fit your syllabus. If you
forget to change the point value before assigning, don’t worry! Any changes to point value will update existing
grades and notify the students of the new assignment value.

How To Video

✅Share to Classroom Extension
http://googleforeducation.blogspot.com/2015/09/get-your-students-on-same-webpage.html

Website explains how the extension works. Basically allows a teacher to force students (who are attached to a
specific Google Classroom) to specific website instantly. The reverse is also true, a student can “push” a site
back to the teacher.

✅Schedule That Assignment
If there was any doubt as to if the Google Classroom team listens to teacher requests, today’s new feature update
proves that they do! Teachers have been clamoring for, and now can, scheduling Google Classroom assignments.

Check out the link below for step-by-step instructions.
http://alicekeeler.com/2016/05/03/google_classroom_schedule_assignment/

✅List ALL Your Student Files
Alice Keeler provides 2 templates to see ALL student work done in Google Classroom. One way to separate
each assignment out to its own tab; the other template (much further down in the blog) keeps all assignments
on one tab which you can sort by student to see total # of assignments turned in. For the blog → click here.
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✅NEW! Guardian Contacts & Email options
Parent participation has a major impact on student learning. Today, we’re launching a new feature in Google Classroom
that will automatically share summaries of student work with parents. Once invited by a teacher, parents and guardians
can receive automated daily or weekly email summaries of student work and class announcements, making it easier to
stay up-to-date on what’s happening in the classroom. (For more … click here)

✅10 Google Classroom Time Savers
LINK

1. Find student work in Classroom by using Drive
2. Let students help by posting a question
3. Adjust notification settings (to get the right amount of email)
4. Use keyboard commands instead of the mouse
5. Open lots of student work at once with the CTRL key
6. Get notified of late student work w/a late work form
7. Get resources in Classroom quickly with the Share to Classroom extension
8. Connect other tools to Classroom quickly
9. Organize & sort your posts with topics
10. Reuse posts so you don’t have to create them again from scratch

✅35 Awesome Apps that Integrate with Google Classroom
Did you know that Google Classroom plays well with others? Yep! Google is known for making their
applications open to working with third-party applications, and Google Classroom is no exception. Are you
using Google Classroom? I have put together a list of 35 Apps that Integrate with Google Classroom, making it
even easier to create lessons and announcements with your favorite apps and resources. Last summer,
Google opened the API for Google Classroom which means that other applications could connect or integrate
more seamlessly with the platform. Translation: more goodies for you and your students! I wish everything
connected to Google Classroom! But this is still a new option for developers, so it is not available through
every application you use in your classroom. Expect this list of apps to grow a lot in 2016.

LINK

Private Comment as Assignment
LINK
For assignments posted in Google Classroom, students are able to leave the teacher a private comment. This is
one of my favorite features because it gives students an opportunity to ask a question privately. Students are more
likely to ask questions through a digital platform than they are in person. The private comment feature, however,
does not have to be restricted to students asking questions.
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✅Michael Fricano II

Don’t delete that classroom LINK

John Sowash
Free Google Classroom course LINK
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Google Docs

Force Others to Make a Copy of a Document
(credit)
Create your document and give it “View only” rights.

1. Click the blue “Share” button.
2. Click “Copy Link” then click “Done”.
3. Share this link in an email to your students. When you paste the link into the email, change the words

“edit?usp=sharing” (or your text) at the end of the url to “copy”.
4. Send your email (or post it in the location where you direct people to grab the link). They will get a screen when

they click the link asking them to make a copy. They will need to click “Make a copy”.
5. The document that opens up is their own copy (name will automatically change to be “Copy of …”).

Find the Word Count in Your Google Doc with this Keyboard Shortcut

When it comes to editing a long document, any shortcut available is much welcomed to make you work faster. Locating
your word count is an easy task to do and there are two ways to do it. The first option is to go to Tools in the menu bar
and select Word count. A small window will appear that will list the amount of pages, words, characters, and characters
excluding spaces. The second way to access this information is through the keyboard shortcut: Command + Shift + C (on
a Mac) or CTRL + Shift + C (on a PC).

Using bookmarks in a document
Bookmarks are shortcuts to specific places within a document. They can be very useful when you need to make a table of
contents, or when you want to jump from one part of a long document to another without scrolling.
Create a link to a bookmark
A bookmark is only useful when you can link to it. Here's how you can create a link to a bookmark:

1. Highlight the text you'd like to link from. You can also just click anywhere in your document to create a link there.
2. Click the Insert drop-down menu and select Link..., or click the link icon in the toolbar.
3. In the 'Edit Link' window, select the 'Bookmark' option to see the bookmarks you've created.
4. Click the bookmark you'd like to link to.
5. Click OK.

If you need to edit or remove the link, click it and the 'Go to link' window appears. In this window, you can see the
bookmark you're linking to, and the Change and Remove links.
Create a bookmark in a document
To create a bookmark in your document, follow these steps:

1. Click where you want to place the bookmark in your document.
2. Click the Insert drop-down menu.
3. Select Bookmark.
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Restrict Viewing/Commenting in Docs to a Time Period
In the share setting, hover over a collaborator to reveal a clock icon … choose how many days (or hours) the collaborator
has access to the doc before it expires. - credit: Alice Keeler

Creating a Writing Journal with Google Docs

Taking advantage of the new outline tool in Google Docs by including headers within the document. This makes it easy to
jump to the current journal entry of a student. Unlike the table of contents, the outline in the left margin of the screen
updates automatically. [This link is a template you can copy to create your own journal - once you’ve made a copy,
customize it to fit your needs & the needs of your students].

Adding Emoji’s in Google Docs
Click on “Insert” then “Special Characters”. From here you have a huge library of not just emoji’s, but all kinds of special
characters to add into your Google Doc. Enjoy!

Showing the Outline in Google Docs
To open the outline, click Tools >Document outline. The outline will open on the left.

HyperDocs
Seriously. HyperDocs = Google Docs on crack. No need to say more.

Interactive Checklists in Google Docs
First, begin by creating the checklist in Google Docs using the “Bulleted list” feature.

● Type out the items in the checklist, with one item per line.
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● Select all the lines of items.
● Click the down arrow to the right of the “Bulleted list” icon in the top toolbar, and then choose the checkbox option from the

pop-out menu.
● Alternately you can click “Format” in the top menu bar, then “Lists”, then “Bulleted list”, and then finally choose the

checkbox option.
● This will place a checkbox at the start of each line in the list.

Now the student can mark off an items in the checklist as they complete them. This can be done by changing a checkbox to a
checkmark at the start of any of the lines.

● Left-click one time on a checkbox, which will select the entire group of checkboxes.
● Now left-click one more time on the same checkbox, which will now just select the single checkbox you have clicked on.
● Now right-click on the same checkbox.
● This will pop up a window where you can choose a new bullet to replace the checkbox.
● Choose the checkmark icon.
● The empty checkbox will now be replaced with a checkbox, indicating the item has been completed.
● Repeat as needed for other checkboxes.
● Credit

Lesson Plan Tool for Google Docs
With Lesson Plan Tool for Docs enabled you can search for standards-aligned lesson plan resources within your Google
Documents. To perform a search simply open the add-on then select a standard from the drop-down menu that appears
on the right-hand side of your document. You can preview any of the resources that appear in the search by simply
clicking on them and opening them in a new tab. When you find a resource that you like, you can click again to add it into
your document. Credit

How to Email & Download a Google Doc as a PDF or Word Doc

Email a Google Doc as a PDF/Word doc:

● Head up to the File menu > scroll down to the “Email as attachment” option.
● In the “Attach as” dropdown menu, you’ll see that it defaults to PDF, but you can easily change this to a

.docx Word document file, plain text, or a few other options if you prefer as well.
● Then just handle this like a regular email. Enter the person’s email address in theTo field, give it a subject,

and add a note if need be. You can also check the box at the bottom to send a copy to yourself.
● Then hit Send, and the converted file will be emailed to your recipient.

Download a Google Doc as a PDF/Word doc:

● Head back up to the File menu > choose the “Download as” item.
● You can choose a PDF or Word document in order to download the file in that format – again, you also

have a few other options if any of those are of use to you.

Click here to watch this video on YouTube.

Use Google Docs to fill out PDF’s
● Move the PDF into Drive > double-click the file to preview it > click the “Open with”dropdown

menu at the top.
● If you don’t already have DocHub installed, you need to click on “Connect more apps.”From

here, search for DocHub and then install it. Once finished, go back to the same“Open with”
dropdown, and this time select DocHub.
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● When you open DocHub for the first time, it’s going to ask permission to access your Drive.
Click on Allow to proceed, and your file will open in DocHub shortly.

● The key to this app is that it allows you to draw text boxes anywhere you want on a PDF, which
then just become fillable fields that you can type into as you like. You can slide these text boxes
around and use the gridlines to assist you in positioning them.

● LINK

Use the Explore Button in Docs
LINK
makes researching and writing reports on the go a whole lot easier. Whether you’re writing about mobile retail
trends or planning your next team offsite, you’ll get instant suggestions based on the content in your document

Transcribe Images Into Editable Docs
Google continues to blur the line between physical and digital. What used to only live on ink and paper can be
edited right in your Drive. The OCR (Optical Character Recognition) feature in Google Drive can convert an
image of a physical page of text into an editable Google Doc. I use this feature to make changes to recipes I
find in cookbooks, but it can also be used for legal documents or school assignments, the possibilities are
endless. LINK (Video is included)

Customize Docs Background
LINK
If you’re looking to add some excitement to your Docs (and plenty of other sites), you need to check out this
Chrome extension.

New & Improved Voice Commands

LINK - voice commands is already a powerful tool, but now you can change font color, highlight, insert
comments, delete, and more … just by telling Google!

Easy Way to Color Code & Organize Ideas in a Google Doc
LINK - use an add-on to highlight & organize notes in your doc

Google Drawing

Graphic Organizers in Google Drawings
Link
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Graphic organizers are a powerful tools for language arts. Students can use them to plan an essay,
compare and contrast characters, detail the sequence of a story, explore the meanings of a word, and
much more.

There are many tools for creating and using graphic organizers, but one great option is Google Drawings.
Some benefits include:

● Loads of ways to add images, shapes, connectors, text, and more
● Easy to collaborate with partners or for a whole class brainstorming activity
● Final product can be shared as is, or can be exported in several formats
● It’s free!

Website contains a folder with roughly 40 templates which can be copies & kept/tailored for yourself.

Google Drawing Resources
Link Eric Curts, once again

5 Apps Templates to use with Kindergarteners
Alice Keeler shares 5 different templates ready-to go for tech skills for the littlest learners. (slides, sheets, &
drawings)
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Google Drive✅

✅Add a Google File to Multiple Folders in Drive
select doc/sheet/etc & hold down shift & z . The organization option will pop up & add to the desired folder.
Credit

✅Set the Expiration Date on Your Google Drive, Docs, Sheets & Slides

Click here to watch this video on YouTube

Google Apps is a great tool to share many documents with both internal and external parties. In today’s collaborative
working world, it’s natural to have many people accessing the same document, and with sharing rights, comes security
concerns. When a document is shared externally, it’s convenient to have certain features available that you as the owner
can still control. These features include the ability to edit write and read access, and now, the ability to add an expiration
date.

Over the next two months, this feature will become available. As an owner or collaborator on the document, you will be
able to set an expiration date for users with comment or view access only. You will not be able to add expiration dates for
users that are already listed as owners or have edit access.

✅How to Insert Special Characters in Google Docs, Slides and Drawings

Click here to watch this video on YouTube

Have you ever wanted to insert a special character but couldn’t remember the name of the symbol? In Google Docs,
Slides, and Drawings, here’s a great way to jog your memory. In these apps, there’s a trackpad you can use to draw the
symbol. Sometimes all we can remember is what a symbol looks like, the names for symbols aren’t always the most
memorable, like the symbol ampersand. Watch the video above to learn how to use this trackpad.

How to Password Protect Your Google Drive Documents on Your iPhone
● First, launch the Google Drive app from the home screen on your iPhone. This will work essentially the

same way on your iPad.
● Head to the Settings menu (the menu with three lines in the top-left corner) > Passcode Lock. Click the

slider to turn this feature on.
● Enter in your passcode. For extra security, we recommend making this a different passcode than what

you use to unlock your phone.
● Enter your passcode again to confirm it.
● credit
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Google Earth

LINK to Google Earth website

Google Earth Walks
LINK → During a Google Earth Walk, students engage in real-world problem solving as they work their way through a
virtual tour on Google Earth. Each placemark offers an engaging, geotagged image as well as a compelling question,
challenging students to apply what they've learned in the real world.

Google Forms

An Intro to Google Forms
by Sarah J. Kiefer LINK

Multiple Google Forms to One Spreadsheet
The magic of Google Forms is the ability to view all of your Form data in a spreadsheet. I use Google Forms a
considerable amount in my classroom. Google Forms basically allows me to be paperless. Any data I need to collect,
including student work, I utilize a Google Form. This means that I have multiple spreadsheets that I need to access when I
need data. It would be nice if I could have all of my Google Forms data in one spreadsheet. (From Alice Keeler)

Link

Templates!
No need to start from scratch! There are now at least 20 templates to choose from.
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Track Survey Progress and Analyze the Results

How useful would it be to be able to see who’s taken your survey and who hasn’t? Now you can track a
participant’s progress on a form. There’s even an option to send a reminder to fill out your form to those who
haven’t yet responded. Under the Response tab, you can see a summary of all responses, or drill down into
individual responses.

Receive Notifications and Status Updates

Once you’ve created a form, it is easy to get distracted while you wait for answers to accumulate. Now you can request
notification emails to be sent your way each time a participant completes your form. Hello, automation!

Restrict Access to Google Forms with These Two Options
How-To Video
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Google Forms makes collecting information easy, but sometimes you don’t want everyone to be able to fill out your form.
Have you ever wanted to set restrictions on who could complete your Google Form? There are multiple ways of
accomplishing this and the above video will walk you through two different options.

The first option allows you to set permissions and identify who can complete your form. Meaning, you can designate
specific people you want to complete the form with the use of a student ID, for example. This is done by creating an
expression in the responses spreadsheet. Once you’ve identified people you want to fill out your form, you can create an
identification column. In the video, we’ve chosen to identify students through student ID numbers. After the IDs have been
created and provided to the participants, you then can build a concatenate formula.

The second option is to password protect your Google Form. To do this, you will have to create two pages for your form.
The first page will be a login in page where you can enable Data Validation and require an exact match. You will need to
provide the password to your form participants. Once they login with the password, they will be granted access to the
second page of your form where you can begin your questions.

To learn more about Google Forms, see this list of articles.

Where to Locate and Download Google Form Add-ons

Click here to watch this video on YouTube

It’s easy to find Chrome extensions, but what about Google Form Add-ons? Here’s a quick video to help you locate

Google Form Add-ons and begin downloading them.

● Create a new Google Form, or go to a Google Form you’ve already created.

● Once you’re in Google Forms, click the More menu in the top right corner. Select Add-ons.
● A new window will appear where the Add-ons are listed. You can hover over each add-on to get a preview of what

they do. To download an add-on, just click the “+ FREE” icon.

Forms Quiz Grading Feature
New → June, 2016 Link

Add Images to Q & A in Forms
LINK
If you want to insert images directly into questions or answers, you need to access your images from a different
place. When you type out your question, click the image icon on the right side.

Adding images as multiple choice answers

● For example, let’s say you have a question like, “Which of the following
images do you think best represents our brand?” and you want your answers
to all be images.

● Click into the first answer space, and then click the image icon on the
right-hand side. Upload or select your image.
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Choose Your Own Adventure Forms
Math style link
Social Studies - Plymouth Rock Activity link

“Smarter” Question Options
LINK
Let’s say you’re planning an all-day event at the office and need to know which day works best for your team. When you

type “What days are you available next week?” Forms will intelligently determine that “Checkbox” is the ideal question

type, and generate related response options that you can add one by one or all together.

Make Sequencing Questions with Google Forms
LINK

Use the directions to create a sequencing item in Google forms. How cool!!!

Password Protect Google Forms
LINK → One of the coolest features is the ability to set a password to block progress in any Form.
All you need to do is create sections and add a question that requires a specific text, set of
digits, or other combination to progress. Follow the steps below to start creating Password
Protected Google Forms!

GMail

Export & Edit Your Gmail Contacts in Bulk
Gooru website w/video to explain how to...
Website

Google MyMaps

MyMaps Helps site
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20 ways Google MyMaps can enhance lessons in any class
Maps touch practically every content area and grade level. There are 20 suggested uses for your

classroom. Click to watch a video

MyMaps, a somewhat unnoticed app in the Google Apps suite, lets students create their own highly

customized maps to share with others and display. (Teachers and schools can create them, too!)

YouTube→ “MyMaps: make, copy, edit pins, & get link to share”

Google’s Geography Trivia Game → Smartypins
Information about it HERE

Link to play the game HERE

Video about MyMaps & Tour Creator LINK

Google Sheets

“An Intro to Google Sheets”

by Sarah J. Kiefer LINK

Calculate how many days you have to work on a project

(credit)
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Using the DATEDIF() function you can calculate the number of days between two dates. I use this when I am assigned a
due date on a project or I am trying to figure out how many days I will be out of office when planning a vacation. Just enter
DATEDIF() and between the parentheses insert the start date, then the end date, followed by the unit of measurement
(“D” for days, “M” for months, or “Y” for years) and voila!

Make sure you are collecting real email addresses

(credit)

If you send out forms to collect email addresses the first thing you need to check is if they are real email addresses.
Depending on how many you collect, verifying each one manually can be extremely tedious. Cut out the busy work by
using the ISEMAIL() function and inserting the email address between the parentheses.

Translate foreign languages

(credit)

I often receive emails or video comments from people all over the world. Not being multilingual it can be tricky to
understand them all. By entering GOOGLETRANSLATE() and selecting the text I want to translate followed by its original
language and then the language I wish to translate it into, I can use my spreadsheet as a virtual foreign language
dictionary.

How to Rotate Text in Google Spreadsheets
YouTube Video (credit)
Fitting your text in your cells is a common challenge in a spreadsheet. There are easy fixes like adjusting the size of your
columns or rows, but sometimes those adjustments can alter your spreadsheet view and the best option to make your text
fit is to rotate it.
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Have you ever tried searching for a rotate button in Google Spreadsheets? You won’t have much luck finding an exact
button, but there are workarounds you can use to rotate your text vertically and customize the degree you want to rotate
your text. If you are working with a spreadsheet that stores a lot of data and requires filtering, then you may want to insert
an image instead. Check out the video above and read the text below to learn these workarounds for rotating text.

To rotate your text vertically:
● Find the text you want to rotate vertically.
● Replace the text in the cell with this formula: =ARRAYFORMULA(CONCATENATE((MID( “Text to become

vertical”, ROW(INDIRECT(“YY1:YY”&LEN( “Text to become vertical” ))),1)&CHAR(10))))
● In the text between the quotation marks (Text to become vertical), replace the text you want to rotate inside those

quotation marks. There are two instances in the formula.
● Hit Enter once you’ve typed out the text.
● Your text will display vertically.

To customize the degree in which you want to rotate your text:
● Find and copy the text you want to rotate.
● Select Insert.
● Click Drawing.
● An “Insert Drawing“ window will appear.
● Select the text box icon and draw your text box.
● Paste the text you want to rotate into the text box.
● Adjust the sizing of the text box as needed.
● Hover your mouse over the top of the text box and wait until you see a plus sign “+.” This symbol means that you

are ready to rotate.
● Rotate the drawing to the degree that works for you.
● When you are done rotating, click Save and Close.
● Your drawing is now in your spreadsheet and you can move it around to where you need it to be.
● To make any adjustments to the text, rotation, color, or other features, select the drawing and find the drop down

menu that appears once the drawing is selected.

Say goodbye to duplicates (in Sheets)
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Duplicates are one of the most common issues in large spreadsheets. Finding them all and removing them can be tricky,
even with the aid of formulas. Remove Duplicates (website) is the pain-free way to rid a Google Sheet of duplicate data
in seconds.

Find Duplicates in Sheets
Link → use conditional formatting and plug in formula in conditional formatting …. Formula =
=countif($A:$A,A1)>1 where A is the column selected to look for duplicates.

How to do text-to-columns in Google Spreadsheets

Click here to watch this video on YouTube
Text can live in many places and thanks to copy/paste, text can be easily moved around from application to application.
However, when it comes to lists and easy organization, pasting can become a little complicated. Pasting in Google Sheets
can become especially difficult when you want to paste a list or text that you want to separate into different cells. The
former solution to separating text was with a script, but Google announced this week that you can now easily convert text
to columns in Sheets with new paste formatting options.

Watch the video demonstration above to learn more.

Creating Pixel Art Using a Google Sheets Template

On this Alice Keeler page, learn how to use Google Sheets to create a pretty cool drawing.
This activity is good for ALL ages. From TK to grade 12. Students can create pixel art of just about anything to

demonstrate their learning. Pixel art chemical bonds might be fun Students are not bound to the 10 colors in the
conditional formatting. Review Alice’s previous blog post on how to make pixel art from scratch.
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Don’t feel bound to stick to this color palate … click on the purple blog posting to find out how to customize your palate.

“Conditional Formatting Pixel Art Template” Ready for your use!

Student Reading Log Template w/Sheets
Link

Building a Table of Contents in Sheets
Link
Have you ever made a spreadsheet so large that you get lost in it? It is something that has happened to the best of us.
While Google Sheets are a great format for recording and crunching data, they can be increasingly difficult to navigate the
larger they get.

Wouldn’t it be cool if you could create a table of contents that would link you to the specific tab you needed info from?
Tables of contents are usually associated with books or large documents but they can also be implemented in Sheets to
make finding info much quicker. Although this is not a Google feature, with this workaround you can add a table of
contents to all your multi-page spreadsheets.

Create an Org Structure in Sheets
Link

Mapping out organizational structures is a time consuming process. Dragging and dropping each piece and then
connecting them with the appropriate connector lines, who has time for that? That is why I use Google Sheets to
automate the process.

After entering all the roles (in the correct format) in Google Sheets, you can turn them into an Org Chart with the chart
creation tool. The chart will update dynamically as you modify the roles in the spreadsheet, so you don’t need to worry
about starting from scratch when things change.
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5 Apps Templates to use with Kindergarteners
Alice Keeler shares 5 different templates ready-to go for tech skills for the littlest learners. (slides, sheets, &
drawings)

How to Automatically Alternate Row/Column color in Sheets
Link

● In Google Sheets, head up to Format and click on Conditional formatting.
● Select “Add new rule.” Select the range using the “Apply to range” field, and then under the “Format

cells if…” dropdown menu, select “Custom formula is.” Then, there are four basic rules you can create
here to dictate how and where you’d like color applied to your sheet.

● To apply a color to all even rows, type =ISEVEN(ROW()). To apply the rule to odd rows, type
=ISODD(ROW()). Click the paint bucket icon to change the color.

How to Split Text into Columns
In Google Sheets, paste your data into a column. You’ll see a little clipboard icon appear in the lower-right hand corner of
your data. Click on that, and you will see the option to split the data into columns. Alternatively, if your data is already in

your spreadsheet, head up to the Data menu > Split text to columns. Click here for more

Insert Images into Sheets
Using the =IMAGE Spreadsheet function allows us to insert an image inside a cell, using the image’s URL. This makes it really easy to
insert images into a particular cell, and will get larger or smaller depending on the size of the cell (while maintaining the image’s aspect
ratio).
There are actually several variations of this function that give you even more functionality:

● =IMAGE(“URL”) – image retains aspect ratio while increasing / decreasing the cell size
● =IMAGE(“URL”,2) – image stretches to fit all edges of the cell
● =IMAGE(“URL”,3) – image retains its original size
● =IMAGE(“URL”,4,50,50) – set the size of the image by replacing 50,50 with desired dimensions

Click here to watch this video on YouTube.

Send Text Messages in Sheets
LINK
Here’s an easy way to send out an invite or reminder for an event: Just enter in your attendees’ cell phone
numbers into Google Sheets, and you can send text messages directly from Sheets. You can send them
instantly or schedule them to send later. (Only 5 Free -- MUST purchase if you want to do more)

Dynamic Dropdown Menu’s in Sheets
LINK w/video
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https://www.bettercloud.com/monitor/the-academy/create-dynamic-dropdown-menus-in-google-sheets/?mkt_tok=eyJpIjoiT0RNNE1HRTBaV1EyTmpnNSIsInQiOiJ4ZG01Y1wvMzEwZlhIOW1YOWVlS1wveXpTc1ptU0lYK3JCMEJhSGFpNmd1TTdDTXREbkh4ZnM5SnlnTmNPXC9LaUJac0xuQVZuMzVVc1hiZHA0MnY3c3pMT21jbFpFbzduelVWUHpMeUdRTHlZND0ifQ%3D%3D


Sometimes when creating dropdown menus in Google Sheets we don’t always know what the options should
be. By using the UNIQUE function, we can create dropdown menus that automatically updated based on what
users are entering. That way, we can choose items based on previous entries or add a new item that will
automatically update our list.

Use the Explore Button in Sheets
LINK
help you decipher your data easily, whether you’re new to spreadsheets or a formula pro. Just ask Explore —
with words, not formulas — to get answers about your data

Merge Data into One Column
Alice Keeler LINK

Clarify Your Charts Using Data Labels
LINK

copyDown Add-On for Sheets
LINK

makes it possible to automate formula calculations in the same spreadsheet rows as your Google Form
submissions.

Rotate text & border options in Sheets
LINK
You can now rotate text in sheets!!!! Yea! You can now rotate the text in a cell in Sheets (Format > Text rotation). This

is especially useful when you need to fit long header names into thin columns, or when you simply want to fit more text on

a single screen.

ALSO→ You can now choose from several new border styles in Sheets, including various thicknesses and double borders,

which are commonly used in financial statements like balance sheets (Toolbar > Borders > Border styles).

Google Sites

The All New Google Sites (help)
LINK
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Google Slides

An Intro to Google Slides
“An Intro to Google Slides” by Sarah J. Kiefer

Activities to do with Slides
Eric Curts provides several activities to do with Slides. Link

Google Slides Cheat Sheet
Shake-Up Learning sheet

5 Apps Templates to use with Kindergarteners
Alice Keeler shares 5 different templates ready-to go for tech skills for the littlest learners. (slides, sheets, &
drawings)

Use the Explore Button in Slides
LINK
dynamically generates design suggestions, based on the content of your slide. Simply pick a recommendation
and apply it with a single click — no cropping, resizing or reformatting required

Free Templates for Slides

Link
Website →http://www.slidescarnival.com/

Use your mouse as a laser pointer
Link (with video)

In Google Slides, click on the button in the top right corner and launch your presentation.
Click on the laser pointer icon at the bottom of your screen.
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http://www.controlaltachieve.com/search/label/Google%20Slides
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You’ll see immediately that your mouse’s cursor is transformed into a laser pointer!

Google Tour Creator

Video about MyMaps & Tour Creator LINK
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